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Abstract:
WebSphere Host Publisher: Modernize Your Green 
Screen Applications!

Did you know that WebSphere Host Publisher is included 
in the iSeries Access Family product? 

WebSphere Host Publisher is a tool you can use to reface 
and streamline those tired-looking green screen 
applications into truly web-looking applications without 
changing your original 5250 application -- you don't even 
need the source code nor do you need a great deal of 
programming skills!   

This product eliminates PC network administration and 
desktop configuration as everything runs on the iSeries 
and only sends HTML to the browser.   You will also hear 
how Host Publisher compares to other IBM refacing tools.  
By the end of this session, attendees will be able to:
1. Understand the capabilities of Host Publisher.
2. See how to use them in an iSeries network.
3. Know what steps to take next in order to start using it

Agenda
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Packaging
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V5R2
5722-XW1

iSeries Access Family

V5R1
5722-XW1

iSeries Client Access Family
5722-XE1, V5R2
iSeries Access for Windows

5722-XE1, V5R1
AS/400 Client Access Express for 
Windows

5722-XH2, V5R2
iSeries Access for Web

5722-XH1, V5R1
iSeries Access for Web

5724-B81, V4.0
WebSphere Host Publisher

5648-E25, V3.5
WebSphere Host Publisher

Starting 6/30/2003
   HATS Limited Edition

Customers with Software Subscription can get 
V5R2 clients by ordering no-charge Feature No. 
2645 of Product No. 5722-XW1

After 6/30/2003, current V5R2 customers 
can get version of Host Publisher that runs 
on WAS V5 and HATS LE by ordering 
no-charge Feature No. 2646 of Product No. 
5722-XW1

After 6/30/2003, current V5R1 customers can 
get version of Host Publisher that runs on WAS 
V5 and HATS LE by ordering no-charge Feature 
No. 2646 of Product No. 5722-XW1

iSeries Access Family - Packaging
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Differences
iSeries Access for Web

vs
HATS LE
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My Personal Folder

Print
Printer output
Printers
Internet Printers
Printer shares
Output Queues

Database
Tables
My Requests
Run SQL
Copy Data to Table
Import Requests

5250
Start 5250 Session

Commands
Run commands (Batch)

Files
Browse Files (in IFS)
File Shares (in NetServer)

Messages
Display Messages
Send Messages
Operator Messages
Message Queue

Jobs
User Jobs
Server Jobs

Customize
Administrator controls access to 
functionsu by user or group of 
users:

Can customize front page
Can limit what tasks can be 
performed

iSeries Access for Web provides many functions besides 5250...
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The iSeries Access Family 
now provides two unique 
ways to start a 5250 session 
to an iSeries.

1.  Access for Web 
Product 5722-XH2, refreshed in 
V5R2, and runs on both V5R1 
and V5R2 iSeries servers
Includes a new, integrated, and 
improved 5250 emulation 
function.

2.  HATS LE
Offers 5250 emulation that is 
quick and easy to set up and 
define
Runs on both V5R1 and V5R2 
iSeries servers.

We will look only at differences between the 5250 interface 
here...

So now 
you may 

be 
wondering 
which one 
to use.  
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Access for Web (5250 emulation) HATS LE (5250 emulation)
If using many other Access for Web functions

Can select 5250 or other functions from the Navigation 
Bar.  Less set-up to simply select 5250 tab for emulation 
needs than to also install/set up HATS LE

Better is only want 5250 session
If the only function you want to make available to users is 
5250 emulation, then it would be easier to use HATS 
LE as that is all the only function it provides.  Its 
Configuration Wizard is easy and quick to set up.  

Can connect to multiple iSeries
End user can easily configure multiple 5250 sessions to 
multiple iSeries servers. 

For HATS LE, the Administrator must go through special 
setup to enable users to access multiple iSeries servers.

One customization applies to all users
You only need to go through the customization once and 
it applies to all users connecting to that instance of 
HATS LE.

Better Browser Back/Forward control
Access for Web ensures that users do not get out of sync 
with their OS/400 applications when using the browser 
back and forward buttons. 

HATS LE requires the administrator to insert a script into 
the HATS application template to disable use of the 
browser Back button to avoid unpredictable results.

Function Keys work with Netscape too
HATS LE enables Netscape users, as well as Internet 
Explorer users, to work with keyboard Function keys, 
etc

Access for Web only supports use of Function Keys and 
page up/down when using Internet Explorer. 

Includes Macro support
The macro support can be used to eliminate the entering of 
repetitive commands or even bypass the second sign-on 
screen. 

HATS LE has no macro support

Rules-based transformation capabilities provide a 
more enhanced GUI-look

All system screens and application screens can have 
drop down lists.  HATS LE can detect selection lists and 
tables and provide an enhanced GUI look not possible 
with Access for Web 5250 emulation.

Templates included
Sample templates included, and are easy to modify.  

Differences - iSeries Access for Web vs HATS LE
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The iSeries Access Family now provides two unique ways to start a 5250 session to an iSeries.
1.  Access for Web (Product 5722-XH2, refreshed in V5R2, and runs on both V5R1 and V5R2 iSeries servers) now 
includes a new, integrated, and improved 5250 emulation function.
2.  HATS LE offers 5250 emulation that is quick and easy to set up and define.

So now you may be wondering which one to use.  Here might be a few points to help you with these choices:

Access for Web
iSeries Access for Web provides many functions in addition to 5250 emulation, ie, work with spool files, printers, 
database, IFS, commands, etc.  HATS LE provides 5250 emulation only -- no other functions.
So this comparison is just of the 5250 emulation portion.

Access for Web 5250 emulation

If you're using the Access for Web default menus and its Navigation Bar, where the 5250 tab is included, it is 
probably more straight-forward to simply use the 5250 tab for your 5250 emulation needs . 
Access for Web 5250 emulation GUI and keypads can be customized for specific users or groups of users - 
whereas HATS LE's configuration applies to all users connecting to that instance of HATS LE.  Thus, Access for 
Web provides the flexibility of enabling users to make different choices for their GUI look.
Access for Web 5250 emulation allows an end user to easily configure multiple 5250 sessions to access multiple 
iSeries servers. HATS LE would need to be deployed and running in multiple instances of WAS to enable users to 
access multiple iSeries servers. 
Access for Web 5250 emulation provides macro support; HATS LE does not.  The macro support can be used to 
eliminate the entering of repetitive commands or even bypass the second sign-on screen.
Access for Web ensures that users do not get out of sync with their OS/400 applications when using the browser 
back and forward buttons.  HATS LE requires the administrator to insert a script into the HATS application template 
to disable use of the browser Back button to avoid unpredictable results.

Notes: Differences Access for Web Vs. HATS LE
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Notes: Differences Access for Web Vs. HATS LE
HATS LE 5250 emulation

If the only function you want to make available to users is 5250 emulation, then it would be easier to use HATS LE as that is all the only 
function it provides, and its Configuration Wizard is easy and quick to set up.  
You only need to go through the customization once and it applies to all users of HATS LE.

However, if you had multiple iSeries servers you would like to have users connect to, or you would like a different look for some 
users versus other users, then you need to do some additional steps.

The first alternative would be to create multiple instances of WAS on the iSeries server and deploy HATS LE to each of those 
instances and configure each deployment to connect to a different iSeries server.  From the end user view, they would need to specify a 
different port in the browser URL because each instance of WAS that was created would use a different HTTP server...which requires a 
different port.

The second alternative is set an override within the HATS LE configuration file (application.hap).  It can be updated with an override 
value like this:

 <class name="com.ibm.hats.SessionOverride">
 <setting name="host" value="true"/>
 </class>

The "host" setting allows you to pass in the name of the server to connect to.  The browser URL would look like this:
http://<servername>/HATSLE/entry?host=<servername to connect to>

So from one deployment, update appliation.hap file, the user can connect to different iSeries servers.
Note:  Setting this override value is not surfaced in the HATS LE configuration wizard GUI so it can only be done by updating the 

application.hap configuration file.
HATS LE, with its rules-based transformation capabilities, can provide a more enhanced GUI-look for system screens as well as host 
applications than the Access for Web 5250 emulation function.  For example, all system screens and application screens can have drop 
down lists.  HATS LE can detect selection lists and tables and provide an enhanced GUI look not possible with Access for Web 5250 
emulation.
HATS LE enables Netscape users, as well as Internet Explorer users, to work with keyboard PF keys, etc, while Access for Web only 
supports use of PF and page up/down keys when using Internet Explorer. 

Combining use of HATS LE 5250 with Access for Web
You could combine the use of the two products by using the Access for Web Customization functions.  This would enable users to come to 
the Access for Web front page, and click on a link and transparently be switched to use the 5250 emulation program in HATS LE.
Both HATS LE and Access for Web 5250 emulators use the OS/400 TELNET function - thus both require 5250 OLTP (interactive feature).  
All other functions of Access for Web, such as working with spool files, printers, database, running commands, etc, run batch. 
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WebSphere Host Publisher

A cross-server product

Included with iSeries Access Family (5722-XW1) at no additional charge...

Use your Host Publisher skills to 
work with iSeries and zSeries 
applications...

x
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Over the last several years, many products and technologies have been introduced to help extend legacy (typically 3270 and 5250 based) 
applications and data to a web browser or Java interface.  Early solutions typically involved a fairly large Java applet being downloaded to a 
workstation.  Others relied upon an HTML page and HTTP server mode of operation to provide the equivalent of a 5250 or 3270 
emulation session. The products have matured and there are numerous options available.

Despite the gold rush mentality on getting to the web, providing a browser interface over a heavily interactive application may not be 
suitable for the end user, especially when trying to exploit efficiencies by linking more closely to your customers, suppliers and trading 
partners. These users typically do not have experience with your application, plus have specific, targeted requests such as entering a 
purchase order or looking up account status. This is especially true in the business to business arena, where application to application 
integration and automation are important. However, organizations have invested literally billions in existing legacy applications that have 
been enhanced and solidified over the years. An ideal solution would be to encapsulate these robust legacy application tasks into reusable 
components that can be used for interactive web applications, as well as enterprise application integration projects for e-business and 
business to business transactions.

The basic objective of WebSpere Host Publisher is simple - enable an existing 5250 interactive application to participate in the e-business 
world, without having to do any code modifications.   With Host Publisher, you can:

Utilize the IBM Host Publisher product to provide a browser interface to our application
Build a Java wrapper layer, or adapter, that provides the data conversion and session management services to interface with the Host 
Publisher representation of our 5250 application
Utilize the IBM Connect for iSeries product and its Java connector option to enable an organization to participate in a business to 
business electronic marketplace, and leverage the strengths of our existing iSeries 5250 based order entry application 

You do not need to be an expert Java programmer, or purchase expensive, inflexible middleware from a dotcom vendor that may not be 
in business in a few weeks, in order to enable your legacy applications to participate in ebusiness opportunities.  You can use iSeries 
Client Access Family, that now includes WebSphere Host Publisher, and be confident that you have a solution that will be long lasting.

Notes: WebSphere Host Publisher
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Turns host applications into e-business applications for web browser users

WebSphere Host Publisher

Browser-based access 

Refaces and streamlines existing green 
screen applications and system screens

Existing green screen still available

Still interactive but Connections can be 
pooled

IBM eServer iSeries
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Benefits to Your Programming Staff:

Feature/Function
They can:

Implement 'new look-and-feel' applications without needing host 
application source code
Work with:

      --5250/3270/VT host applications
      --Create new Database applications  using a variety of JDBC 
drivers 
      --Java Host applications

Consolidate multiple applications into a single web application
No programming required, you use the simple graphical 
wizard-like interface of Host Publisher Studio

Business value
Your Results:

Reduces the costs and risks associated with new application 
development
Since it is built on WebSphere technology it can be used other 
Websphere technologies to extend host data to pervasive 
devices like SmartPhone or personal digital assistants. 
Since it is based on open industry standards, it can be reused in 

other e-business applications  

Benefits to Your Business:

Feature/Function
You Can:

Put a GUI on green screens
Provide Internet access from any browser supported 
by WAS
Support new users inside and outside your enterprise
Extend the reach of legacy applications and data

--Streamline navigation through your applications 

Business value
Your Results:

Applications have a modern appearance
Applications are easier to learn and use
Lower training costs
Better responsiveness to your customers
More information available 24 X 7
Costly call centers and VRU's are offloaded
Existing transactions are streamlined

Notes: Benefits and Business value
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Server / 
Desktop 

Requirements

WebSphere Host Publisher 
V4.0

5724-B81

WebSphere Host Publisher 
V3.5

5648-E25
iSeries HW Interactive Interactive
Ports 80 (HTTP), 443 (HTTPS) 80 (HTTP), 443 (HTTPS)
Encryption SSL in browser SSL in browser
Browser Whatever supported by WAS 

(Netscape, Internet Explorer)
Whatever supported by WAS 
(Netscape, Internet Explorer)

Desktops 
supported

Any O/S with supported  
browser --  Windows  95, 98, 
Me, NT, 2000, XP, Linux, AIX, 
UNIX, Solaris, Macintosh, 
OS/2

Any O/S with supported  
browser --  Windows  95, 98, 
Me, NT, 2000, Linux,  AIX, 
UNIX, Solaris, Macintosh, 
OS/2

Server / Desktop Requirements...
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Wireless devices

iSeries
pSeries
zSeries
xSeries

OS/390 
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Internet iSeries 
Legacy
 Apps

IBM iSeries

GUI Delivered as a 
HTML

TELNET OS/400 

JDBC 

 DEC/UNIX 
Browsers

(Internet Explorer, 
Netscape...)

Multi-platform - server, connecting users
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WebSphere Host Publisher offers many capabilities

5. Can combine portions of multiple 
panels or multiple applications 
into a single Web view

5250, 3270...

6. Includes capabilities to control 
heavy Web use and large 
networks

Tools to enhance performance, 
fallover when Web server not 
available, manage multiple servers 
from single administer console

7. Cross platform development tool
Skills invested in Host Publisher can 
be used with zSeries and iSeries 
applications as well 

Extend existing applications to the Web...

1. Modernization done without 
source code

Host application continues to run as it 
always has...

2. Can Web-enable system screens 
Including iSeries commands (such as 
query a database file)

3. Can take an existing full-function, 
in-house application and present 
only selected paths to Web users... 

4. Can add database functions to 
existing host application

Can access information from any 
relational database

IBM eServer iSeries

© 2003 IBM Corporation

This is a Mainframe Application but could just 
as well been an iSeries application
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User must provide a 
valid Security Code 
in order to access 
this application
This screen quite 
unnecessary

x

x

State of Virginia - Host Application
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Multiple paths 
through this 
application

Case Management System
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Note
Order listed changed

From: Law, 
Chancery, 
Criminal
To: Criminal, 
Law, Chancery

Several paths through 
application not 
included in this view

Check out
http://www.piner.com 
to see this application 
and others that have 
been modernized 
using Host Publisher

Webized only 3 paths through this existing application

IBM eServer iSeries
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Customer Reference Application - before using Host Publisher

Porter County Indiana - Tax Details Screen
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Customer Reference Application - after using Host Publisher

Porter County
Tax Search Form
Tax Information Results
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"Porter County has experienced a strong demand to provide more convenient 
access to public records like tax and judicial data, and people expect the 
simplicity and familiarity of the web environment . 

WebSphere Host Publisher provided a rapid conversion of our AS/400 property 
tax application to a browser interface and allowed us to streamline the 
application by combining screens and functions. The result has been a 
significant reduction in retrieval errors, connectivity costs, and improved 
public satisfaction with our systems.

We have plans in the near future to convert two additional green screen 
applications for web access with Host Publisher. "

 Sharon Lippens, Director, Data Processing, Porter County, Indiana

Tell your customers to check out http://www.piner.com  to see other applications that 
have been modernized using Host Publisher

Customer Quote
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Kawasaki Motors U.K. 
supports its dealers and 
sales force over the 
Internet with WebSphere 
Host Publisher

Miami-Dade

Host Publisher saves 
citizens time while 
enhancing government 
efficiency

Other iSeries Customers using Host Publisher
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How Do You Use 
Host Publisher

to modernize your applications?
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Host 
Publisher  

Host 
Publisher 

Studio

Host 
Publisher 

Server

Development Environment
Uses task oriented, graphical user 
interface 
Generates Integration Objects
Contains Java bean factories
Generates fully customizable Web 
pages (ie, Java Server Pages) 

Run Time Environment
Provides session management, license 
monitoring, run-time administration, load 
balancing and log and trace management
Supports SSL encryption and DES encrypted 
passwords
Supports integration with other IBM connectors

Development environment is 
a task-oriented, graphical user 
interface that runs on a PC 
with Microsoft Windows

Run time environment 
runs on WAS on iSeries

Key Components
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Host Publisher provides the following benefits to the iSeries 
environment:

Provides Web integration with 5250, Java Database 
Connectivity (JDBC) and Java host applications without 
requiring any changes to the existing application itself.
Allows for easy consolidation of multiple applications into a 
single composite application or Web page for presentation to 
Web users
Includes and integrates with Websphere Application Server and 
Websphere Studio to provide a comprehensive solution for 
delivering host data to Web users and to new Websphere 
e-business applications. 
Works with Websphere Transcoding Publisher to extend host 
data to pervasive technologies such as SmartPhone devices and 
personal digital assistants. 
Provides a wide range of host access options: HTML to Web 
browsers, XML Gateway for Java applications, and reusable 
Host Publisher Integration Objects for Java applets and 
applications. 
Helps to leverage your investment in Host Publisher by using 
integration objects that are based on open industry standards 
that can be reused in new e-business applications, and reducing 
the costs and risks associated with new application 
development. 
Can be implemented without programming, using a simple 
graphical wizard-like interface. 
Includes IBM Network Dispatcher, which enables the balancing 
of user network traffic across a pool of Host Publisher servers. 

Notes: Host Publisher Makeup
Host Publisher is also comprised of two categories of components - 
development and runtime.   

The development component is called the 'Host Publisher Studio '.  It is a 
development toolkit that contains three components: 
1.Host access for interacting with 5250 application tasks (entering 

input, extracting output) and representing them as reuseable Java 
bean components 

2.Database access for performing SQL inserts, updates and deletes in 
conjunction with DB2/400 and representing them as reuseable Java 
bean components 

3.An interactive application builder for integrating Java components 
(host access beans, database access beans, or other Java applications) 
to build web enabled applications, using Java Server Pages (JSP) 

The runtime component is call the 'Host Publisher server'.  It uses 
WAS to provide the runtime support for Host Publisher applications. 
Host Publisher applications can contain multiple components (ie pieces 
of several 5250 applications, host screens and DB2/400 queries) from 
multiple servers (iSeries, mainframes, etc.), and represent these as part 
of a firewall-friendly, thin client HTTP- and HTML-based solution. All 
programming logic runs on the server, even the 5250 session 
management tasks. It is well suited for extending host application 
functionality over the Internet, without requiring the end user to 
download large client components or try navigating through an 
interactive 5250 application. Since the 5250 tasks run on the server and 
not the browser, you are not trying to 'force fit' a session-based 
protocol (TN5250) over a sessionless (HTTP) connection. This is an 
advantage over other HTTP-based products.
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1. Install/configure Host Publisher Server 
in WAS

get it ready for use

2. Start the WebSphere Host Publisher 
Studio

Host Access (5250, 3270, VT) or 
Database Access (JDBC) paths

3. Step through the application or host 
screens -- capturing the information 
you wish to publish

generates Java beans called Integration 
Objects

4. Import the Integration Objects into 
the Host Publisher Application 
Integrator (studio)

generates JSPs and J2EE.ear files

What are the steps?

5. Perhaps polish your 
application further

5. Could use a product in the 
WebSphere Studio family or 
other products to enhance 
the graphical look of the 
pages 

6. Install the J2EE files on the 
application server using 
WAS Administrator

7. Ready for Web users to 
enter url to access the 
application

IBM eServer iSeries
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Step 1.
Install/configure Host Publisher Server in WAS

get it ready to use
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Product 
Number Product Name Option $

57xx-SS1 OS/400 V5R1 or later Base w/HW
57xx-SS1 Operating System/400 Host Servers 12 N/C
57xx-SS1 Operating System/400 Qshell Interpreter 30 N/C

57xx-SS1
57xx-AC2

or
57xx-AC3

If you plan to use Secure Sockets Layer (SSL):
OS/400 Digital Certificate Manager 
Cryptographic Access Provider (56-bit)

                         or
Cryptographic Access Provider (128-bit)

34 N/C
N/C

N/C
57xx-DG1 IBM HTTP Server for iSeries N/C
57xx-JV1 Developer Kit for Java

Developer Kit for Java Version 1.2
Base

3
N/C
N/C

57xx-JC1 Toolbox for Java N/C
57xx-TC1 TCP/IP Connectivity Utilities for iSeries N/C
57xx-XW1 iSeries Client Access Family

WebSphere Host Publisher (5648-E25, V4.0) or
WebSphere Host Publisher (5724B81, V3.5)

$

5733-AS3
5733-WA3
5733-WS4
5733-WA4

WebSphere Application Server - Standard Edition V3.5
WebSphere Application Server - Advanced Edition V3.5
WebSphere Application Server - Advanced Single V4.0
WebSphere Application Server - Advanced Multi V4.0 
Will support WAS 5.0 versions by 6/30/2003

N/C
$
$
$

Server Software Requirements
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WebSphere Host Publisher is included with iSeries 
Access Family (5722-XW1):

Production environment must be installed on iSeries 
servers

Does 'Concurrent' license checking at runtime

Must have iSeries Access Licensed Program Product 
(5722-XW1) installed on Server.

If you have a Processor-based license of 5722-XW1, 
unlimited number of users could be using Host Publisher, 
Access for Web Access, and Access for Windows 
products simultaneously 

OS/390 

OS/400 

JDBC 

 DEC/UNIX 

HTML Web 
browser

Host Publisher Ts & Cs
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WebSphere Host Publisher Server  - CD

To be installed on iSeries

Host Publisher documentation included on CD

Planning and Installation Guide for iSeries

Administrator's and User's Guide. 

WebSphere Host Publisher Studio - CD

To be installed on Windows 98, Me, NT 4.0, 2000, or XP

Also look at iSeries Access for Web Installation Guide (SC41-5518) and README for 
additional information on installing and configuring WebSphere Host Publisher.

Use this for 
Host 
Publisher 
too

What Comes in Your Package...
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Performance mainly dependent on WebSphere Application Server
Minimal network traffic as only generating HTML page
Run the workload estimator at:

http://www-912.ibm.com/supporthome.nsf/document/16533356

Also look at recommended minimum system requirements for WebSphere 
from above web page

Use First Customer Assist Program to get WAS configured and running

http://www-919.ibm.com/servers/eserver/iseries/developer/
                    websphere/assistance.html

Performance Considerations
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First Install Customer Assistance for Websphere Application Server Standard  or Advanced Edition for iSeries or AS/400.
 

We would like to welcome new customers to the Websphere arena and provide them with assistance that may be needed to 
install and configure Websphere Application Server, either Standard or Advanced Edition.
By starting with a working instance of Websphere Application Server and reviewing the sample programs provided, your time 
spent with Websphere Application Server will be more productive and enjoyable.  
Through your application and acceptance into this program, the Rochester Support Center will provide you with 8:00AM - 
5:00PM Central Standard Time phone support assistance in setting up a Websphere Application Server test environment.

 This assistance includes:
1. Documentation clarification
2. Verify you have all Prerequisites available: Software, Hardware, PTF's, and Communication configurations
3. Creation of a default Websphere instance 
4. Configuration and enablement of Websphere for an HTTP server 
5. Installation and use of Websphere Client based Admin Console (excluded Firewall configuration) 
6. Validate the above by running of a sample servlet. 

http://www.iseries.ibm.com/developer/websphere/assistance.html

Notes: First Install Customer Assistance
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2. Start the WebSphere Host Publisher Studio
Host Access (5250, 3270, VT) or Database Access (JDBC) paths

3. Step through the application or host screens -- capturing the 
information you wish to publish

generates Java beans called Integration Objects

4. Import the Integration Objects into the Host Publisher 
Application Integrator (studio)

generates JSPs and J2EE.ear files

Steps 2-4.  Working with the Studio
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WebSphere Host Publisher Studio
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Host Publisher Studio is divided into 3 parts for creating and 
managing a project

1. 'Host Access' for your 
existing 5250 applications

Generates JavaBeans called 
Integration Objects 

2. 'Database Access' is used to 
create new SQL requests 

Generates SQL Integration Objects

3. 'Host Publisher Studio' / 
'Application Integrator'

Generates HTML, JSPs, and J2EE.ear 
files

Development Environment Components
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There are three unique 
steps you go through 
when using the 'Host 
Access' or 'Database 
Access' functions

These phases become 
your interaction macros

1. Connect and log on 

2. Navigate and extract 
data 

3. Log off and disconnect 

Notes: Working through the phases...
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To work with an existing 5250 application
We start by selecting 'Host Access' and start working through the 
Wizards.

First we define what we're going to do...

Working with 'Host Access'...

Watch on the 
left as Host 
Publisher is 
building the jsp 
(presentation)
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The 'Host Access' component works with existing 
5250, 3270, and VT applications or host screens 
to provide data and functions in a web page

Host Access interacts with host tasks
Host 'green screen' applications or system screens (ie, OS/400 screens such as 
working with spool file)
Entering input, extracting output
Represents them as reuseable Java bean components
Data from multiple host applications or system screens can be combined in a 
single web page 

Benefits
Host Publisher hides the complexity of obtaining the data
No changes to host applications needed!
Mission critical data can be presented to new users in new ways

Notes: Host Access
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Step through 
your 
application
Picking the 
input/output 
fields you want 
to display
Look on left 
now...

Capturing your screens...
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Remember 
that Porter 

County 
Application?

Telling Host Publisher what fields you want to present...

IBM eServer iSeries
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Continuing 
through the 
5250 
application
Identifying 
what you want 
to display...
Look at left 
side now...

Working through the studio wizards...
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You can use the Host Publisher Display Terminal function for 
debugging

You can run the 5250 application in its green-screen view right next to your 
modernized application
Enables you to see the paths through your 5250 application that your modernized 
application is going to take.

Testing and Debugging your web application...

IBM eServer iSeries
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Database Access - select JDBC driver
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The 'Database Access' component is used to create Integration 
Objects that can access databases

Supports any relational database that provides JDBC drivers

Can access DBA data over the network using JDBC driver in 
DBA Connect

Database Access enables you to:

Perform SQL inserts, updates and deletes in conjunction 
with DB2 UDB for iSeries, and 

Represent them as reuseable Java bean components 

The 'Database Access' wizards are used to 
create SQL Integration Objects that can 
access relational databases

Includes:
iSeries 
JDBC 
driver
AS/400 
Toolbox 
for Java

Notes: Database Access
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Wizard builds SQL 
statements

Tables
Join
Condition
Columns
Sort
SQL
Insert
Update

Now use Database Access wizards to built database 
application...
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The Database Access application enables you to create an 'Integration Object' that encapsulates a database statement.  
This Integration Objects are reusable building blocks you can use to build Web pages in Host Publisher Studio or your 
own server-side Java components such as servlets or Enterprise Jave Beans.

The Database Access application provides a wizard interface that enables you to quickly create, modify, and run 
Structured Query Language (SQL) statements.  With the wizard, you can query a relational database to retrieve data 
from the tables in the database, or update or remove a database entry.  You do not need to know SQL syntax to 
complete the wizard.  Tabs guide you through the process of building and executing a valid SQL statement.  You can 
navigate by clicking a tab at the top of the window or Back or Next at the bottom of the window.  Click Finish to save 
the Integration Object with the information you have typed.  Finish displays a save dialog box for you to specify a name 
for the Integration Object.  If you did not specify a User ID on the Connection Pools tab, the User ID Warning dialog 
box reminds you that the field is empty, which may cause an error at runtime.  Finish is enabled when you have 
connected to a database and selected the tables to access on the 'Tables' tab.

Before you start, ensure that the database client software is installed and configured on your workstation.  Specify the 
Java database connectivity (JDBC) address for the database.  The format of the database address depends on the JDBC 
driver you use to connect to the database.  If you select one of the JDBC drivers from the drop-down list in the Driver 
field, the required format for the driver is displayed in the Database URL field.  For example, the AS/400 Toolbox for 
Java JDBC driver requires jdbc:as400://[host], where host is the fully-qualified network name of the database host.  The 
square brackets ([ and ]) surrounding the host and database variables must be removed from the syntax when you enter 
the variable value.

Notes: Using Database Access wizards
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The 'Application Integrator' component is an interactive application 
builder for integrating Java components

Host access beans

Database access beans

Used to build composite applications 
Java beans and objects to be combined with other back-end data sources to create a 
composite Web application

Java is presented as a consolidated application
Allows for the publication of any Java bean or object to the Web

Facilitates interaction with that object

The 'Application Integrator' component 
is used to build Java Server Pages 
(JSPs) and J2EE.ear files

Host Publisher Studio - Application Integrator 
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Skills / Education

IBM eServer iSeries
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Skills you need to use Host Publisher

Host Publisher Studio provides 
the tools to develop web-enabled 
applications

You must be proficient with the 
host application or database

You will use the Host Publisher 
Studio wizards to create java 
objects

Do not need to be a Java 
programmer

You will use the Host Publisher 
Studio wizards to build Web pages 
for the applications 

Basic JSP knowledge is 
required to modify the 
applications

Skills
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You need to understand the data source well enough to model interactions with the 
data source (which may be a complex process)

You need to be able to predict all possible paths, including error paths
If you are not familiar with the data source, then building the Integration 
Objects may be a painful exercise with much time spent starting over

You build and test the Integration Objects within the Host Publisher Access User 
Interface first.  You:

Model tasks, not screens

Identify tasks to be performed
Build a flow diagram and exercise the diagram
Allow for error paths (or prevent them effectively)
Allow for global screens (screens which could appear at any time)

You build pages to complete the application and TEST
You can customize pages to suit standards.
Once the application has been thoroughly exercised and tested, you then save 
the customization of the JSP pages

Skills for building a Web application...
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IBM WebSphere Host Publisher 
Application Development Workshop

Course Code:  SW910
For schedule information, call 
1-800-IBM-TEACH (426-8322)

'Building A Java Adapter Over a 5250 
Application to enable B-B 
transactions' article

An example of taking an 
interactive 5250 order entry 
application running on an iSeries 
machine, and making it accessible 
via a web browser
http://www.iseries.ibm.com/developer/
java/topics/hostpubadapter.html  

  

Programmer's Guide
On Host Publisher Studio 
CD

Assistance
eServer Custom 
Technology Center (CTC) 

Tutorial on CD
Contact Carole Miner for copy

WebSphere Host Publisher 
QuickStart Services

A comprehensive suite of 
services to assist customers with 
the installation and 
customization of Host Publisher

Installation & Connectivity Module - 3 days
Host Publisher Workshop Module - 5 days
Host Publisher Remote Consulting Module - 40 
hours

Host Publisher - Education

Acrobat Document
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IBM WebSphere Host Publisher Application Development Workshop (Course Code:  SW910) - 

this course is for anyone that wants to build Host Publisher applications across a variety of platforms (not just iSeries) 
and who has basic web application development  skills including HTML knowledge and an understanding of the Java 
programming Language.   The focus of this course is on implementing IBM Websphere Host Publisher (Host Publisher) 
applications using advanced techniques designed to handle a wide variety of application scenarios. Advanced topics will be 
discussed to give the student in-depth understanding of Host Publisher technology and how to apply this technology to 
real-world applications. Labs will be used extensively to ensure  students can apply the topics discussed.  The Host 
Publisher Application Development Workshop is a technical workshop that will discuss techniques for developing 
advanced Host Publisher applications.
Duration:   4 Days
Delivery Method:   Classroom
Skill Level:   Basic
Tuition:   $2200 

For schedule information, please call 1-800-IBM-TEACH (426-8322).

Notes: Host Publisher Education
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Redbooks 
iSeries Access for Web V5R2 and WebSphere Host Publisher 
V4.0, SG24-6804-00 on the web at: 
http://publib-b.boulder.ibm.com  
/cgi-bin/searchsite.cgi?query=SG24-6804
A Comprehensive Guide to IBM WebSphere Host Publisher V3.5, 
SG24-6281 
New Advanced Functions in IBM WebSphere Host Publisher V2.2: 
Access Host Applications from Web Devices, SG24-5964-00 
New Advanced Functions in IBM WebSphere Host Publisher V2.2 - 
Access Host Applications from Web devices, SG24-5964-00 
Building Integration Objects With IBM SecureWay Host Publisher 
Version 2.1 , SG24-5385-00 

White papers 
IBM WebSphere Host Publisher Version 4.0 Implementation Guide 
ssRTE.exe for use with Lab 1 in Implementation Guide [Executable 
- 139 KB] 
Setting up and Using the IBM® Express Logon Feature for 
WebSphere Host Publisher 3.5 
IBM WebSphere Host Publisher Version 3.5 Implementation Guide 
IBM WebSphere Host Publisher [PDF Version- 200KB] 
Using WebSphere Studio with Host Publisher 
Designing an Application Using IBM WebSphere Host Publisher 
Understanding Host Publisher Integration Object Chaining 

Product documentation 
IBM Websphere Host Publisher V4.0 Readme 
IBM WebSphere Host Publisher V4.0 Administrator's and User's 
Guide
IBM WebSphere Host Publisher V4.0 Programmer's Guide and 
Reference
IBM WebSphere Host Publisher V4.0 Messages Reference
IBM WebSphere Host Publisher V4.0 Planning and Installation Guide 
for IBM AIX, Sun Solaris, and Microsoft Windows 
WebSphere Host Publisher V3.5 Application Development: Building 
Integration Objects for use in Java Server Pages: Lab 1 
WebSphere Host Publisher V3.5 Application Development: Building 
a Integration Object Chaining Application- Lab 2 
WebSphere Host Publisher V3.5 Application Development: Using 
Conditional Macros, Error Logic and Global screens - Lab 3 
IBM Websphere Host Publisher V3.5 Readme
IBM WebSphere Host Publisher V3.5 Administrator and User's 
Guide (GC31-8728-02) 
IBM WebSphere Host Publisher V3.5 Programmer's Guide and 
Reference
IBM WebSphere Host Publisher V3.5 Planning and Installation Guide 
for Windows NT, Windows 2000, AIX, and Solaris (SC31-8730-03)
IBM WebSphere Host Publisher V3.5 Planning and Installation Guide 
for iSeries (SC31-8734-03) 

Key informational websites or links
iSeries Access Family:  www.ibm.com/eserver/iseries/access
Host Publisher:  www.ibm.com/software/webservers/hostpublisher/

http://www.ibm.com/software/webservers/hostpublisher/library.html
Reference Material (Redbooks, manuals, whitepapers, etc.)
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Step 5.
Perhaps polish your application further

Could use a product in the WebSphere 
Studio family or other products to enhance 

the graphical look of the pages 

pretty as a picture...

First we use the Host 
Publisher Studio to create 
our basic Web-to-host 
application, then we make it 
'production ready'

IBM eServer iSeries
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To get this kind of look takes an extra step...

You will want to use a product like 
IBM's WebSphere Studio products 
to enhance the presentation of the 
application



The following steps describe how to import Host Publisher generated 
JavaServer pages (JSPs) into WebSphere Studio

Create the application with Host Publisher Studio
1.Install sample application UofMApp1.hpa Note: UofMApp1 and
   UofMApp2 are installed together, so you can skip this step if
   UofMApp2 is already installed.
2.Start Host Publisher Studio from the Start menu. 
3.Close the opening Welcome to Host Publisher Studio! dialog box,
    if it appears. 
4.Open the sample application as follows: 
    1.From the menu bar, select File > Open Application.... 
    2.Double-click the UofMApp1 folder in the Open Application File
       dialog box. 
    3.Select UofMApp1.hpa. 
    4.Click Open. 
5.Click File > Transfer to Server... to transfer the sample application
   to the Host Publisher Server. Refer to the IBM WebSphere Host
   Publisher Administrator's and User's Guide for details. 
6.Use Host Publisher Server Administration to deploy UofMApp1.
   This final step makes the application available on the Web. 

Import the JSPs into your WebSphere Studio project
7.Start WebSphere Studio from the Start menu. 
8.Select Create a new project from the Welcome to IBM
   WebSphere Studio dialog box. If this dialog box does not appear,
   click File > New Project... from the menu bar. 
9.Type UofM1 as the Project Name, then click OK. 
10.Import the Host Publisher Studio-generated JSPs as follows: 
      1.From the menu bar, select Insert > File.... 
      2.Select the Use Existing tab in the Insert File dialog box. 
      3.Click Browse and navigate to the
                 x:\HostPub\Studio\UofMApp1 folder. 
      4.Press and hold Ctrl, then click inputPage.jsp and
         outputPage.jsp to select them both. 
      5.Click Open, then click OK. 

Notes: Managing Host Publisher Studio-generated JSPs in WebSphere Studio 

Modify the JavaServer Pages within WebSphere Studio
11.Double-click inputPage.jsp in the File View window to open Page Designer 
with the selected file. 
12.Apply your creativity to enhance the page. When you are done, click File > 
Save to save the revised file, then click File > Quit to close Page Designer. 
13.Repeat the process to enhance outputPage.jsp as desired. 

Publish the modified JSPs from WebSphere Studio to Host Publisher 
Server
Note: Your publishing target must be a Host Publisher Server. 
14.Configure WebSphere Studio to publish the JSPs to the correct Host 
Publisher Server application directory as follows: 
     1.Select the Publishing window and expand the publishing stage with
         which you are working. 
      2.Right-click on the server and select Properties from the pop-up menu. 
      3.Click Targets... in the Properties dialog box. 
      4.Set the html target to the corresponding application directory on your 
Host Publisher Server target (for example, 
                   x:\HostPub\Server\production\documents\UofMApp1). 
       5.Click OK to close the Properties dialog boxes. 
15.Configure WebSphere Studio to publish files with relative links: 
       1.From the menu bar, select Tools > Publishing Options.... 
       2.Check Relative to parent file for Style of links. 
       3.Click OK to close the Publishing Options dialog box. 
16.Publish your WebSphere Studio project. Note that you may see warnings 
about broken child links in inputPage.jsp and outputPage.jsp. You can safely
ignore these warnings and click OK in the Files to publish dialog box. The 
warnings can be ignored because your earlier transfer from Host Publisher 
Studio has already installed the additional files. Click here for more details. 

Test your modified application
You can access your modified Host Publisher application with the same URI 
used for the original application. For example, the sample application deployed 
here can be accessed at  

http://your.HostPublisherServer.com/HostPublisher/
UofMApp1/inputPage.jsp. 
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IBM WebSphere Development Studio Client for IBM iSeries V4
Included with WebSphere Development Studio for iSeries, Product Number 
5722-WDS (processor-based)
Or can purchase stand-alone Product Number 5724-A81 (user-based)

iSeries-specific enhancements for Java development 
iSeries-specific enhancements for Web development 
Integrated workstation based iSeries development tools including Remote System 
Explorer/Remote System Framework and JLpex editor 

See Software Announcement Letter 202-127 dated June 4, 2002

This tool will satisfy the needs of most iSeries developers...
iSeries specific enhancements are included in these Web and Java developments 
tools to make it easier to develop Web and Java applications for the iSeries server.   
However, this Development Studio for iSeries does not provide support for 
applications requiring the use of EJBs or J2EE. 
For these functions, iSeries developers need to use WebSphere Studio Site 
Developer Advanced. 

WebSphere Tools
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WebSphere Studio Application Developer (V4.0.3 for Linux and Windows)

Part Number 45P8105 (user-based) 
A powerful Java development environment that supports JDK 1.3, configurable 
runtime, incremental compilation, scrapbook, dynamic debugging, and refactoring 
Advanced Web, Java, and XML development environments designed to J2EE 1.2 
specifications 
Web services tools to quickly develop, describe, and deploy Web services-enabled 
applications based on open, cross-platform standards like UDDI, SOAP, and WSDL 
A Relational Schema Center focused on relational database design and database 
administration tasks such as import and mapping schemas and other advanced 
functions 
An integrated roles-based team environment 

For more information, see http://www.ibmlink.ibm.com/usalets&parms=H_202-057

WebSphere Studio Application Developer is an easy-to-use, integrated development 
environment for building, testing, and deploying J2EE applications that rapidly grows 
and adapts to meet the most stringent business demands.  This WebSphere Studio 
Workbench-based product is designed for Java and J2EE developers requiring 
integrated support for Java, EJB, Web, Servlets, JSP, XML and Web services. 
Additionally, it offers many quality and productivity enhancement functions to help you 
shorten development and test cycles. 

Other WebSphere Tools... 
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Step 6.
Install the J2EE files on the application server 

using WAS Administrator
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Host Publisher Server (Runtime)

Can administer 
multiple Host Publisher 
Runtime Servers from 

one Host Publisher 
Administrator Console 

WAS

Windows 
NT 4.0, 
2000, XP

Administrator 
Console

Working With the Server Side

IBM eServer iSeries
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The Host Publisher Studio allows you to import the integration object created from the 5250 application example, 
and define a web browser interface for entering the input data, and receiving the output. As with the host access 
toolkit, the studio provides an interactive wizard that helps you get started quickly.    It is important to reiterate that 
you do not change the original application and you don't even need access to the OS/400 display file source. 

If you can write your own applications using the beans or HACL interface directly gives you a great deal of control, 
however it requires utilizing some fairly low-level programming techniques.  It also requires developers to handle 
situations (such as screen recoginition and waiting for the session's input inhibited indicator to clear) before 
processing the next step.  To avoid having to do this tedious coding, Host Publisher gives you a much easier means of 
interacting with the 5250 application, and it creates Java bean components that you can then utilize in your own 
application development tools, such as IBM VisualAge for Java.  Host Publisher is often more than adequate for 
building the appropriate solution. For more demanding application requirements, one can import these integration 
objects into a full-fledged Java IDE such as VisualAge and build solutions. 

See the simple example Building A Java Adapter Over a 5250 Application to enable B-B transactions at 
http://www.iseries.ibm.com/developer/java/topics/hostpubadapter.html  that shows an example of taking an interactive 
5250 application, then introduces you to 'web enabling' it via the Host Publisher product.  Next,  you will use this web 
integration infrastructure to create what is commonly termed as an adapter.  Put simply, an adapter is analogous to a 
human translator that provides interpretation between people that do not speak a common language. In this case, the 
Java adapter understands the interactive 5250 application transaction flow and structure of the input and output data. 
The adapter also understands a Java runtime environment direct program call.  This allows applications such as 
Connect for iSeries to take advantage of the robust, well-tested 5250 order entry application infrastructure running 
on an iSeries machine, and make it accessible via a web browser.    For interactive, browser-based applications. 

Notes: Host Publisher Sample Programs
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The navigation pane 
on the Host Publisher 
Administration page 
contains functions for 
the Host Publisher 
Server 

Server Status 
Administration 
Connections 
Application 
Administration 

Problem 
Determination 
Tools 

Set Trace Options 

Mature...
Scalable...
Available...

Fine-Tuning the Host Publisher Server for the Web

IBM eServer iSeries
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Connection Manager
Set of Java classes 
Encapsulates connection management

Session creation, priming, and destruction
Connection pooling
Userid/password pooling functions
Support Host Access (3270, 5250, VT) and Database (JDBC) 

Administration
Java servlet and associated JSP pages
Accessed via Web browser
Monitors and controls state of run time environment

start and stop server
license management
pool management

Connection manager
Application Administration

Problem determination
XML Legacy Gateway Administration

New Capabilities In Host Publisher V4.0:

Multi-language support 
When using Host Publisher Administrator (on 
server) can view the Host Publisher documentation 
in  languages other than the server's default language

Software Maintenance Utility
A new command-line tool to help you apply software 
fixes

Notes: Host Publisher Server
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Typical security mechanisms available 
through the Web can be used to control 
authentication and access to existing 
applications including:

Secure Socket Layer (SSL) for data 
encryption between browser and web 
server as well as authentication

Secure Socket Layer (SSL) also provides 
encryption between Host Publisher and 
Host applications

Security mechanisms deployed for host 
application systems remain available to 
control access and authorization

Secure access to Web applications and Host 
Publisher Administration by using access 
controls provided in WAS and HTTP server

Internet

HTTP or 
HTTPS port

Telnet to 
5250 
application 
(can used 
SSL)

SSL in the 
browser

5250 
application

5250 
application

WAS

Security Features...
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Application Caching

Precompiles page into a Java Servlet

If someone else asks for same page then the servlet is rerun

Page recompiled only when it changes
Increases transaction rates and gives faster response time

Connection Pooling

For JDBC and 3270/5250/VT access 

Pool of connections open to data sources

Can specify that all requests serialize on connection cache (so 
if 25 connections in pool and in use then 26th request waits 
for free connection) or can specify that once initial "X" 
connections in use then create an "X+1" connection

Performance Features...
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Supports WAS Workload Management features

Vertical and horizontal cloning
Can have multiple JVMs in WAS, and these can be clones

Vertical cloning is limited to one machine (vertical cloning), and 
horizontal cloning is spread across multiple machines

Benefits are:
Improved throughput as requests can be distributed across multiple 
JVMs

Better fault tolerance because if one JVM fails the user request can be 
processed by any remaining clone that can handle the request. 

If someone else asks for same page then the servlet is rerun 

Vertical cloning is also useful when configured on a machine which is 
powerful enough that a single JVM cannot effectively utilize its CPU 
power (such as on a multiprocessor machine)

RAS Features...
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Support for WAS V4.0 (J2EE compatibility)  
Support for AEs, AEd and AE
This includes migration of Host Publisher applications to achieve J2EE compatibility

Web Services
Quickly extend legacy services as new web services
IOs and EJBs are enabled as Web Services. Web Services creation occurs in WebSphere 
Studio

WebSphere Portal Family support
Extend legacy content as new portal content- WPS 2.1

Accessibility (CI 162)
Web applications produced by Host Publisher Studio are accessible
Keyboard accessibility for all components but HP Admin and DB access.
Added documentation of accessibility features

Server Multi-Language support
Host Publisher Administrator and documentation 

Serviceability tools
Software Maintenance Utility and Information Bundler

iSeries two stage install (install and config)

Host Publisher V4.0 Enhancements
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Web Services provide a way for applications to connect and interact on the Web more easily and efficiently.  Web Services are 
self-contain, modular applications that can be described, published, located, and invoked over the Web.  Platform-neutral and based on 
open standards, Web Services can be combined with each other in different ways to create business processes that enable you to 
interact with customers, employees, and suppliers.

Typically, Web Services use Internet protocols, such as HTTP, use XML message formats, and are plugged into Web Service registries 
where other developers can combine and deploy them.  Think of them as strategic building blocks for automated business processes that 
can be deployed across your enterprise and shared with other enterprises.

Support for Web Services has been implemented in a number of IBM software products, including WebSphere Application Server and 
WebSphere Studio tools (such as WebSphere Studio Application Developer) at the 4.0.2 level or above.

You can use the Host Access and Database Access components of Host Publisher Studio to create supporting files that enable Host 
Publisher Integration Objects and EJB Access Beans to be deployed as Web Services.  Application Integrator assembles these Java objects 
(and optionally JSP pages that reference the Java objects) into a J2EE .ear file.  You can them import the .ear file into a new or existing 
WebSphere Studio project, where you can create and deploy Web Services.

To create an Integration Object in Host Publisher and then enable it to become a Web Server, you would perform the following steps:
1. Using Host Publisher Studio and create 1 or more Integration Objects or EJB Access Beans with Options > Create Web Services 

Integration Object Support checked.
2. Import the Web Services Integration Objects or EJB Access Beans into Application Integrator.  Create an applications that consists of 

Web Services Integration Objects, EJB Access Beans, or both, and then generate an .ear file for the application by clicking File > 
Create J2EE Archives.

3. Import the .ear file into a J2EE-enabled WebSphere Studio tool (for example WebSphere Studio Application Developer).
4. Use the WebSphere Studio tool to create a Web Service.
5. Generate a sample application and run it to test your Web Service.
6. Complete development and testing of the application you imported in step (3).
7. Deploy the completed application.

See White Paper 'IBM and the Strategic Potential of Web Services' at 
http://www-3.ibm.com/software/solutions/webservices/pdf/May13_IBM_WebServices.pdf

Notes: Web Services
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Step 7.
Ready for Web users

 to enter url
 to access the application
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WebSphere Host Publisher (V4.0) - Studio
provides National Language Versions (NLVs) 
for:

Chinese (Simplified and Traditional)
English
French
German
Italian
Japanese
Korean
Portuguese (Brazilian)
Spanish
Turkish

New in WebSphere Host Publisher V4.0:  
Multi-language support 
When using Host Publisher Administrator (on server) 
can view the Host Publisher documentation in  
languages other than the server's default language

WebSphere Host Publisher (V4.0) - Server 
provides National Language Versions (NLVs) 
for:

Chinese (Simplified and Traditional)
English
French
German
Italian
Japanese
Korean
Portuguese (Brazilian)
Spanish
Turkish
Arabic
Belgium Dutch
Croatian
Czech

Danish
Dutch
Finnish
Hungarian
Norwegian - Bokmal
Polish Language
Portuguese
Portuguese MNCS
Romanian
Russian
Slovakian
Slovenian
Swedish 

WebSphere Host Publisher NLVs

Note:  WebSphere Host Publisher does 
not support secondary languages.
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Host Publisher - Key Differentiators

Can take an existing full-function, in-house 
application and present only selected paths to Web 
users... 

Can merge/split applications and screens

Can translate system screens also

Source code not required

Existing green screen still available 

Supports multiple types of user interfaces

5250, 3270, etc

Easily extend just a portion of existing applications to the Web...

This tool enables 
you to 'really' take 
an existing host 
application and 
move it to the 
worldwide Web!
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Other Products

IBM eServer iSeries
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Before and After WebFacing  

WebFacing
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After WebFacing

Can do more with 
existing application 
by using WDSc 
tools... 

... Like this

IBM eServer iSeries
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Key Differentiators

IBM WebFacing Tool

Conversion tool .. from DDS source to JSPs

Semi-automatic conversion

No interactive feature required with V5R2 and new 
hardware

Designed for iSeries

Uses WDSc for iSeries to provide unique iSeries 
functions to programmer
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5) HATS5) HATS
Rules Based TransformationRules Based Transformation

Real Time TransformationReal Time Transformation

3) Screen Customizer3) Screen Customizer
Customize GUICustomize GUI
Supports HOD, PCOMMSupports HOD, PCOMM

3270, 
5250

1) Personal Communications1) Personal Communications
Industry Leading EmulatorIndustry Leading Emulator
File Transfer / Printer SessionsFile Transfer / Printer Sessions

3270, 
5250, 

VT

2) Host on Demand2) Host on Demand
Java Applet for 5250 or GUIJava Applet for 5250 or GUI

File Transfer / Printer SessionsFile Transfer / Printer Sessions

3270, 
5250, 

VT

WebSphere Host Integration Solution
Host Integration 
Solution includes 
WebSphere App 
Server and WSAD

3270, 5250, 
VT, Java,  

JDBC

4) Host Publisher4) Host Publisher
HTML Solution with support for XML, JavaHTML Solution with support for XML, Java

Captured Integration ObjectsCaptured Integration Objects

3270, 
5250
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Host Access Transformation Server (HATS)

Converts green screens to GUIs 
on the fly, in real time

A web-to-host 3270, 5250 HTML 
emulator...
Preserves existing application 
flow...

Translates system screens too...

Easy Web-to-host first step
Has a rules-based 
transformation engine...
"Near" load-n-go implementation
Low skills requirement

Zero footprint on the desktop

Industry-standards 
HTML, HTTP, HTTPs

IBM eServer iSeries
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Capabilities ...

HATS Studio plugs into the 
Eclipse-based WebSphere Studio, 

and provides an easy-to-use 
wizard-based environment for 
converting host screens to a 

web-like appearance and 
functionality

Designer is plug-in to WebSphere 
Studio Development Tools

Eliminates need to customize every 
screen

Rules-based data stream 
translator

Additionally customizable
Customize individual screens
Play and record macros
Add tabbed folders and graphs
Store and retrieve global 
variables
Can integrate with WebSphere 
Portal
Skip and combine screens
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Host screens are converted to GUIs on the fly, in real time
On-the-fly screen conversion using the rules-based transformation engine. HATS does not "break down" when changes are made to the 
host application.

Easy Web-to-host first step
Default rules allow your host application to be on the Web within hours of loading the software. There is no  requirement for programming 
skills, and there is no need to customize every screen.  If further customization is rrequired this can be done at the customers own pace.

Eliminates need to customize every screen
Due to the rules-based transformation engine not all screens require customization,  and when changes are made to the host application 
HATS will continue to work without modification.

Low skills requirement
HATS Studio, which plugs in to the Eclipse-based WebSphere Studio, is an easy to use wizard-based environment for converting host 
screens to a web-like appearance and functionality.  No programming skills are required.

Preserves existing application flow
HATS does not require any changes to the Host Application.

Rules-based, customizable
HATS Studio provides easy-to-use wizards for customizing how host components are displayed. Use the WebSphere Studio or any 
industry-standard HTML editor to add: logos, graphics, backgrounds, Web links and other HTML elements. 

Customizations are saved as reusable rule sets that can be applied to any host screens that share similar requirements.
HATS can apply: an individual rule set to each host application; different rules sets to a single host application for different end user 
communities; the same rule set to multiple host applications.

"Near" load-n-go implementation
Default rules allow your host application to be on the Web within hours of loading the software.

Zero footprint on the desktop 
Only software needed on the client is a Web browser, which provides support for 3270 and 5250 hosts.

Virtually unlimited functionality
Adding customization by using Macros, Global variables, Tabbed folders, Graphs, Java Widgets (e.g. calendar,calculator). 
Open J2EE architecture allows virtually unlimited flexibility and extensibility.

HATS requires all configuration to be done in the HATS Studio (a plugin to WebSphere Developer Studio). Once configuration has been 
completed in the Studio, the application is assembled into an enterprise application and installed on a WebSphere Application Server.  Once 
it is started, it can begin to service clients. 

Notes: Key Selling Points - HATS

IBM eServer iSeries

© 2003 IBM Corporation

Example

HATS 
Transformation 
Using Default 

Rules

Traditional 
Green 
Screen
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Features in both HATS and HATS LE
Default host screen transformation
Configuration of host connection settings
Ability to chose a standard template
Ability to turn on/off application and host 
pads
Keyboard support

Features in HATS, not in HATS LE
Customize individual screens
Play and record macros
Add tabbed folders and graphs
Store and retrieve global variables
Integrate with WebSphere Portal
Skip and combine screens

Differences - HATS vs HATS LE

IBM eServer iSeries
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Function HATS HATS LE
On-the-fly rules-based conversion of host screens to HTML GUIs Yes Yes
No need to access or modify source code Yes Yes
Host applications can be deployed to the Web within hours Yes Yes
Does not require modification when changes are made to host applications Yes Yes
Zero-footprint, zero-download - only code needed on the client is a Web browser Yes Yes
Supports iSeries subfiles Yes Yes
Provides native keyboard support Yes Yes
Secure HTTP (HTTPs) and Secure Socket Layer (SSL) security Yes Yes
Runs with WebSphere Application Server V4 & V5, including V5 Express Yes Yes
Leverages reliability and scalability of WebSphere Application Server Yes Yes
Works with Internet Explorer and Netscape Web browsers Yes Yes
Supports 5250 hosts Yes Yes
Supports 3270 hosts Yes No
Requires a WebSphere Studio installed on PC (either V4 or V5)  to customize 
HTML

Yes No

Uses Web-based Configurator and Management tool  to customize HTML No Yes
Runs on iSeries Server Platform Yes Yes
Runs on AIX, Windows, Solaris, and zSeries Server Platforms Yes No

Comparison of HATS and HATS LE
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Function HATS HATS LE
Any individual screen can be fully customized Yes No
Generate and run macros Yes No
Skip and combine screens Yes No
Store & retrieve data in global variables Yes No
Enter data on behalf of end user Yes No
Convert text entry fields to valid value lists Yes No
Create tabbed folders (with easy to use wizards) Yes No
Create bar & line graphs (with easy to use wizards) Yes No
Redirect users to other URLs Yes No
Globally replace text Yes No
Add business logic Yes No
Print locally with PDF printing function Yes No (1)
Use HATS portlet to integrate with WebSphere Portal Yes No

Comparison of HATS and HATS LE

(1) Can combine use of iSeries Access for Web to work with spooled printer output and convert to PDF 

IBM eServer iSeries
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iSeries Access for 
Web
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My Personal Folder

Print
Printer output
Printers
Internet Printers
Printer shares
Output Queues

Database
Tables
My Requests
Run SQL
Copy Data to Table
Import Requests

5250
Start 5250 Session

Commands
Run commands (Batch)

Files
Browse Files (in IFS)
File Shares (in NetServer)

Messages
Display Messages
Send Messages
Operator Messages
Message Queue

Jobs
User Jobs
Server Jobs

Customize
Administrator controls access to 
functionsu by user or group of 
users:

Can customize front page
Can limit what tasks can be 
performed

iSeries Access for Web provides many functions on iSeries...
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WebSphere Host on Demand

Internet

W
ebS

phere H
ost 

O
n-D

em
and

Java 
Applet

IBM iSeries

Web Browser

iSeries 
Legacy

 Apps

5250 Emulation

Basic 5250  Emulation 
Translation from 5250 data stream to HTML at execution time
May be done via Java applet

Uses Screen Customizer for GUI (reaching end-of-life)

Available via:
WebSphere Host Access Client Package
WebSphere Host Integration Solution

Interactive Job Workload

TELNET
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Software Announcement 202-222 
September 24, 2002 

Excerpt:
This will be the last release of Screen Customizer. The IBM strategic solution for 
rejuvenation of legacy applications is WebSphere Host Access Transformation Server which 
delivers rules-based transformation of host screens with advanced customization. This 
product will be exclusively available within WebSphere Host Integration Solution V3. 

See announcement letter via:  http://www2.ibmlink.ibm.com/

Notes: Screen Customizer reaching end-of-life
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Could combine the use many products...
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Could include a link 
in here that started 
various refaced 
applications -- 
maybe on another 
system...

iSeries Access for Web - sample 'customized' front page

IBM eServer iSeries
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Using iSeries 
Access for Web 
5250 interface

RPG Application - AS/400 WSG BOAT DEMO  

Using HATS LE 
interface
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Could reface 
application using IBM 

WebFacing Tool

Boats application - WebFacing 

Or modernize with 
HATS

IBM eServer iSeries
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Host Publisher

Boats applications - Host Publisher
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Main Features

iSeries Access 
for Web HATS LE Host Publisher

IBM 
WebFacing 

Tool
HATS

Web-enables existing 
Applications

Based on Java 
Technology

Presentation

Yes

Yes

HTML, JSPs, 
Servlets

Yes

Yes

HTML, JSPs, 
Servlets

Yes

Yes

HTML, JSPs, 
ServletsYes

Yes

Yes

HTML, JSPs, 
Servlets

Yes

Yes

HTML, JSPs, 
Servlets

Runtime Environment WAS 
ASF Tomcat

WAS WAS WAS WAS

Supported Browsers

MS Internet 
Explorer 5.0 +

Netscape 4.7 
(AIX, Linux) 
and 6.2 
(Windows

Opera 5.0 
(Linux), and 6.0 
(Windows)

MS Internet 
Explorer 5.0 + 

Netscape 6.0  
Netscape 4.72 

(no keyboard 
support)

MS Internet 
Explorer 5.0 +

Netscape 4.x or 
later versions

MS Internet 
Explorer 5.0 +

MS Internet 
Explorer 5.0 +

Netscape 6.0  
Netscape 4.72 

(no keyboard 
support)

Interactive Feature Required No - unless using 
5250 Yes Yes No - with V5R2 

and new hardware Yes

Supported Host Interfaces 5250 5250 5250, 3270, VT52, 
VT100, VT220

5250 - from DDS 
Source.  Source 
must be available 
for each screen 
format

5250, 3270

Web-enables System 
Functions

Yes Yes Yes

No - limited 
support for 
selected 
commands in 
WDS V5

Yes

IBM eServer iSeries
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Main Features (continued)
iSeries Access 

for Web HATS LE Host Publisher
IBM 

WebFacing 
Tool

HATS

Host Application 
modernization

No, other than 
runs in browser

No, other than 
runs in browser Yes Yes Yes

SQL Database Access Yes No Yes No No

Code Changes Required No No No
No - although may 
choose to optimize 
for the Web

No

Programming effort to 
convert host interface to 
Web interface

None None

Using Studio:
1. Record host 
screen navigations 
and create IOs 
that encapsulate 
those navigations.
2. Build JSP 
pages that require 
IO input and 
render IO output

None - unless 
DDS keywords are 
not supported by 
WebFacing

Two methods:
1. default 
parameters - no 
pgming effort
2. customization -  
tracing application 
execution path, 
defining rules

Customization

Can customize 
what iSeries 
functions user can 
access

Customize screen 
look and 
keyboards

Yes - JSP pages 
can be 
customized, and 
IOs can be reused 
in a WAS 
application 
(Servlet, Web 
Services, EJB)

1. CODE designer
2. Cascading style 
sheets
3. Web Tools

1. Web Tools

Allows exposure of Java 
artifacts to other tools

No No No Yes
No - may create 
Java extensions to 
the application

Merge/split of application 
screens No No

Yes - handled by 
macro recorder

Yes -with 
programming 
changes

Yes - handled by 
macro recorder
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Summary

Many of the products highlighted in 
this presentation can be positioned 
as complementary to each other

Each product brings great strengths 
in a particular area...

Determine what product is right for 
the task at hand...

One may be right for this task...

But the next project might well be 
better suited for one of the other 
products...

Another project might call for a 
combination of these tools

Browsers
(Internet Explorer, Netscape...)

Windows

Opera

Application 
Server - 

WAS
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